










































































































































































































































































































































































































































































































































































Image re-touching 

I m age compositing 

The hard edge 
between the 
water and 
texture was 
softened using 
the blur tool. 
Text was then 
added to the 
top of the 
image. The 
text was 
created 
in Adobe 
Illustrator 3.0 
and saved as 
an EPS file. The 
EPS file was 
then placed on 
a separate 
alpha channel 
and sized to fit 
the layout. A 
Guassian filter 
with a pixel 
factor of 4 was 
applied to the 
letter selection 
to create the 
soft edge. The 
alpha channel 
was then 
applied onto 
the image and 
filled with 
white for the 
glow. The EPS 
text file was 
placed again 
and overlaid 
over the glow. 

Technical Note: Images modified with Adobe Photoshop 2.0 • images scanned from 35 mm transparencies with Scitex's Iris Smart Scanner at300 dpi • layout with 
PageMaker 4.2 • color separation on Agfa Compugraphic SelectSet 5000 at 2,400 dpi at 150 I pi 

-
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MAc-graphics · 

The grayscale image was first opened in Photoshop. The entire image was then 
copied onto the clipboard for later use. 

Using a combination of the paint and airbrush tool, various parts of the statues 
were painted over with soft pastels colors. 

The sky was then selected with the lasso tool. A 80% Cyan color radial blend was 
filled in and the noise filter was applied to give the sky a stippled effect. 

The previously copied image was pasted over the painted version. Using the 
paste control in the Edit menu, the gray values were merged with the painted one. 

The abili ty of Photoshop to work in various mode (e.g. black and white, grayscale and color) makes it a versatile application to do the kind of work you see above. We 
started off with a grayscale image and then converted it to CMYK mode for adding color elements into it. Simple techniques such as painting and using the paste control 
in the Edit menu to control the opacity of pasted images allow you to create visually exciting color images from black and white ones. 



Im ag e r e -t ouc h 1ng 

Pa i nt i ng b l ack and w h ite 

A soft pastel 
orange color 
was airbrushed 
onto the 
statues to give 
them a little 
warmth. As we 
find the bus 
and people at 
the lower right 
hand corner of 
the image 
distracting, we 
had them 
removed by 
copying the 
trees on top 
and pasting 
over them. 

Technical Note : Images modified with Adobe Photoshop 2.0 • images scanned from a b/w photograph with Scitex's Iris Smart Scanner at 300 dpi •layout with 
PageMaker 4.2 • color separation on Agfa Compugraphic SelectSet 5000 at 2,400 dpi at 150 lpi 
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M A c -graphics (0 

8-bit. A system used for displaying colors and 

grayscales on your Macintosh screen. An 8-bit video 
system is capable of displaying 256 (28) colors or 
grayscales, at a time, out of 16.8 million colors 

which the Macintosh is capable of generating. See 
also bit. 

24-bit. A system used for displaying colors and 
grayscales on your Macintosh screen. A 24-bit video 
system is capable of displaying, at a time, the full 
16.8 million colors which the Macintosh is capable 
of generating. See also bit. 

Alignment. Process of specifying how elements 
(text and/or graphics) align on a page, towards one 

another or on a grid. For text alignment, see ragged 
left, ragged right, centered and justification. 

Artwork. Any black and white or color original pre­
pared for reproduction by manual or mechanical 
means. Also called mechanicals. 

Ascender. The part of lower case letters such as 
b d f h which rise above the x-height. 

Asterisk. The sign • which you will get when you 

press shitt-8 on your keyboard. 

Baseline. An imaginary horizontal line along which 

the bottom of capital letters and most lower case 
letters such as a c e align. 

Bit. An acronym for a binary digit. A binary digit 

represents either an on or off signal. In computers, 
all information (whether text, graphics, audio, video) 
is represented in bits. 

Bitmap. A file, display or print format in which 

information in each pixel is represented. 

Bleed. Images on the artwork which extend 
beyond the trim marks. 

Blow-up . To enlarge or an enlargement. 

Body type. Usually a 14 points (or less) size 
typeface used for setting text on a page. 

Body. The vertical area (f rom ascender to 
descender) occupied by a character. 

Book. The medium weight of a typeface intended 
for text setting. 
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Box setting. Setting text with both sides aligned. 

Same as justified. 

Braces. 1 }. The symbols which you get when 

you press open and close square brackets on your 
keyboard while depressing the shift key. 

Brightness. How dim or bright an object appears 

to be. See also HSB. 

Broadsheet. A term commonly used to refer to a 
page the size of a full-size newspaper. 

Bromide . Light sensitive paper used for printing 
from the Macintosh by high resolution imagesetters. 

It is a version of photographic paper. 

Bullet. The symbol • which you get when you 
press option-a on your keyboard. 

Camera-ready. Artwork that is ready for the print­

ing process, i.e. for making negative/positive/plate. 

Cap height. The distance from the baseline to the 
top of a capital letter. 

Caption. Text used to describe an image on page. 

Center spread. The pair of pages which appear 

at the center of a publication, e.g. pages 4 and 5 of 
an 8-page publication. 

Centered. A method of aligning text in which all 
lines in a paragraph are aligned from the center. See 
alignment. 

Chain. Refers to a stream of linked text, flowing 
from one page or column to other pages or 
columns. 

Character. Includes upper and lower case letters, 
numbers and punctuation marks that comprise a 
font. 

CMYK. Short for cyan, magenta, yellow and black, 
the process color in which you can specify the 
percentage of cyan, magenta, yellow and black to 

simulate any color of the spectrum. 

Collating. Gathering pages in the correct order. 

Color separation. Preparation of color artwork 
for printing by separating it into individual colors. 
There are two methods of color separation: process 



color separation and spot color separation. In pro· 

cess color separation, the artwork is separated into 
four colors: cyan, magenta, yellow and black. In 
spot color separation, one separation is made for 

each color used in the artwork. 

Condense. To compress one or more characters 

horizontally. 

Continuous tone. Any image such as a photo· 
graph that has a complete range of tones from 

black to white. See also halftone. 

Contour. A photograph from which all the back· 
ground has been removed or etched out. 

Copy. In computer terms, to duplicate. In printing 
terms, the manuscript from which text is to be input. 

Crop marks. Crosses drawn or printed on a page 
to indicate where a printed page should be trimmed. 

Cropping. The technique of trimming the edges 

or part of an illustration to fit a given space. 

Cut marks. Same as crop marks. 

Default. The settings and features (such as font 
and size) which you encounter when you open a 
new file in an application on the Macintosh. Most 

programs allow you to change the default settings. 

Descender. The parts of lower case letters g j p q 
and y which extend beneath the baseline. 

Digitizing. The process of converting an image 

on paper, film, negative, positive, etc into digital 

form that can be stored in a computer. 

Display. Short for Visual Display Unit (VDU), your 
Macintosh screen or monitor. 

Dither. A technique of using two colors to create 

the appearance of a third. For example, dithering 
using black and white simulates gray. 

Drop caps. The first character of a paragraph which 
is set in a larger size than the rest of the characters 

in the paragraph, occupying more than one line of 
vertical space. 

Drop shadow. A shadow effect obtained by 

duplicating an object and setting the duplicate on 
one side of the original. 
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MAC - graphics dictionary 

Dummy. A rough sketch, a scaled page layout, 
or a preliminary drawing representing the final art· 
work. 

Element. A block of text, a graphic, a line, a half· 

tone image, etc. 

Em. The amount of horizontal space occupied by 

the letter M in any font in a normal (not condensed 
or expanded) style and in a particular size. 

En . Half the horizontal space of Em. 

EPSF. A file format used by many Macintosh 
drawing programs. An EPSF file is in two parts: one 
part consists of PostScript code that describes the 
image and the other part consists of a graphic screen 

representation in OuickDraw format which is used 
for displaying the content of the file on screen. 

Expand. To stretch one or more characters 
horizontally. 

Face. See font. 

First line indent. Setting the first line in a para· 

graph away to the right of the remaining lines in the 
paragraph. 

Flush left. See ragged right. 

Flush right. See ragged left. 

Folio. Same as page number. 

Font. A set of characters including alphabets, 
numbers, accent marks and punctuation marks 

with a unique appearance in a particular style. For 
example, the Times typeface consists of four fonts: 
Times Roman, Times Bold, Times Italic and Times 
Bold-italic. 

Footer. Space in the bottom margin used for set· 
ting recurring items such as page number. chapter 

title, book title, etc. See also header. 

Fount. Same as font. 

Galley. Text set in continuous columns in a given 
width prior to page make-up. 

Gradation. A screen fill in which a shade of gray 
or color smoothly tapers to another shade of gray 

or color. 
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Graduated. See graduation. 

Grain . The direction in which the fibers line up 
when a sheet of paper is made. 

Grayscale . A shade of gray, derived from a per­

centage of black, assigned to an image or a pixel on 
a computer screen. 

Grid. Consists of non-printable horizontal and 

verti cal lines drawn to help position text and 
graphics on a page accurately. 

Gutter. Refers to space between columns. 

H & J. hyphenation and justi fication. See 
hyphenation and justification. 

Hairline. Any rule which is about a quarter of a 
point (0.25) thick. 

Halftone. Refers to the negative or positive fi lm 
which is obtained after the break up of a photograph, 

using a process camera, into fine dots required for 
printing. 

Hanging indent. Also called outdent. The first 
line in a paragraph is set away to the left of the 
remaining lines of the paragraph. 

Hard copy. A printed copy of the contents of a 
computer file. 

Header. Space in the top margin used for setting 

recurring items such as page number, chapter title, 
book title, etc. See also tooter. 

Heavy. A particular weight of a typeface, thicker 
than bold. 

HSB. Acronym for hue, saturation and brightness. 

Hue. The key characteristic of a color. The hue of 
bright red or dark red is red. 

Hyphenation. The process of breaking words which 
do not fit in the space available at the end of a line. 

lmagesetter. A high resolution output device 

which receives images from a Macintosh and 
exposes the image on bromide or fi lm. 

Impression. The result of the process of trans­
fering an image from an offset plate to paper. 

Indentation. A system of setting text in relation 
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to the margins. There are four types of indents: (a) 

left indent, (b) right indent. (c) first line indent and 

(d) hanging indent. 

Inside. Refers to the right margin of a left page 

and the left margin of a right page in a double-sided 
publication. Same as gutter. 

Justification. Alignment of text in a paragraph in 

such a way that all lines are aligned from the left 
and right except the last line of a paragraph. 

Kerning. Reducing the amount of white space 

between alphabets. 

Landscape . A horizontal page orientation in which 
text and graphics are set along the width of the 
page. Also known as wide. 

Layout. The arrangement of text and graphics on 
a page. 

Leader. A row of dots, dashes or any other 

character used to guide the eye between items 
in columns such as an entry in an index and its 
corresponding page number. 

Leading. Vertical space between lines of text. Lead­

ing is usual ly measured from baseline to baseline. 

Left indent. All lines in a paragraph are set away 
to the right of the left margin. 

Letter spacing . Refers to the horizontal space 
between letters. 

Ligatures. A ligature is a single character used to 
represent two or more characters. Some common 

ligatures are fi fl. 

Light face. A particular weight of a typeface, 
thinner than medium. 

Line art. An image consisting of only black and 

white elements without continuous tone. 

Logo. An emblem or symbol consisting of type 

and/or illustrations representing a product or an 
organization. 

MAC-graphics®. Graphics produced with the 

Macintosh hardware and software. 

Margins. Space between the edge of the page 
and the printed area on the four sides of a page. 



Mean line. An imaginary horizontal line that marks 
the tops of lower case letters without ascenders. 

Measure. The width of a text block. 

Mechanicals. See artwork. 

Moire . An undesirable pattern on printed halftone 

due to poor angling of screen or registration. 

Negative. Any image on paper, screen or film 
where dark elements appear light and light elements 
appear dark. 

Newsprint. Paper used for printing newspapers. 

Offset lithography. A method of printing. 

Origin . The starting co-ordinates of an image 
measured from the top and left edge of the page 

or margin. 

Outdent. See hanging indent. 

Outside . Refers to the left margin of a left page 
and the right margin of a right page in a double­

sided publication. 

Overlay. Transparent paper or film placed over 
artwork for the purpose of showing the breakdown 

of color in mechanical color separations. 

Pantone®. A standard for color matching. 

PI CT. A file format for storing 8-bit black and white 
images. Newer versions of PICT known as PICT2 

and PICT 2 (24-bit) allow storage of 8-bit color and 
24-bit color images. 

Pixel. Abbreviation for picture element. The indi­
vidual display dots that make up your Macintosh 
screen display. The display of the built-in Macintosh 

screen, for example, consists of 512 pixels horizon­
tally and 342 pixels vertically. 

Plate . A thin, flat and rectangular piece of metal 
(made of aluminium, zinc, etc) onto which the image 
of an artwork is transferred and mounted on an 
offset printing machine to make copies. 

Point size. The size of characters in a font 
measured from ascender to descender. 

Point. A unit of measurement, approximately 
1/72nd of an inch. 
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MAC-grap h ics d ict i o n a r y 

Portrait. A vertical page orientation in which text 

and graphics are set. Also known as tall. 

Positive. The opposite of a negative image. 

PostScript. A page description language used by 
Macintosh programs to describe the contents of a 

page to be printed to a PostScript printer. 

Print run. Number of copies to be printed. 

Proofreading. The process of reading a proof to 

detect mistakes in spelling, punctuation, style, font, 
size. etc and marking corrections on the proof. 

Proof. A trial print taken to check for mistakes. 

Proofing . The process of obtaining trial copies 

(or color separation proofs) of color artwork 
before printing. There are two methods of proofing: 
off-press and on-press. As their names suggest, 

on-press proofing is when an offset press is 
used to print proofs, and off-press proofing is 
getting proofs using any method other than an 

offset press to make trial copies, e.g. 3M, Dupont, 

Kodak, etc. 

Proofing Bar. A system to help offset printer in 

quality control and detecting printing problems. 

Qu ickDraw. A graphics description language used 

by the Macintosh to display text and graphics on 
the screen and to print on non-PostScript printers. 

Ragged left. A method of aligning text where all 
lines in a paragraph are aligned from the right but 

staggered on the left. See alignment. 

Ragged right. A method of aligning text where all 

lines in a paragraph are aligned from the left but 
staggered on the right. See alignment. 

Recto. A right hand page or an odd number page. 

Registration marks. Marks, usually consisting of 
crosses within circles, printed on color separations 
to facilitate accurate registration during printing. 

Registration. The exact positioning of two or more 
printing impressions. 

Resolution. Sharpness of an image measured in 
pixels per inch in the case of monitors and dots per 
inch in the case of printers. 
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RGB. Red, green, blue. A color mixing method 

used by color monitors to mix percentages of red, 
green and blue light to create any other color. 

Rivers. A term used to refer to too much white 

space appearing in a block of text. 

Rule . A straight line drawn at any angle, thickness 

or pattern. 

Run-around. To make text flow along the path of 

a line, box or an illustration. 

Run-on. To reposition text in a line in such a way 
that it continues at the end of the previous line. 

Sans serif. Without serif. See serif. 

Saturation. The attribute of a color in relation to 

white. The lower the saturation, the whiter the color. 

Scale. To reduce or enlarge an image to lit a 

given size. 

Scanned image. Any image that has been cap­
tured by a digitizing device such as a scanner, video 

camera, etc. and stored in a Macintosh. 

Screen. A piece of film used lor breaking up 

continuous tone images (such as a photograph) 
into halftones required lor printing. Screens are 
designated by number of ruled lines they contain, 

from 50 (coarse) to 300 (very line) lines per inch. 

See also tint. 

Serif. Short strokes which project from the main 

strokes of a character. 

Set. To type characters and apply attributes such 

as font, style, size, etc. 

Skew. To slant an element horizontally, vertically 

or both. 

Slab serif. A type of font in which characters have 

rectangular serifs. 

Small caps. Capital letters whose height is the 

same as the x-height in a given font and size. 

Solid setting . Setting lines of text without 

leading. 

Spacing. Adjusting spaces between letters, 

words and lines. 
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Spine. The bound edge of a book. 

Spread . A pair of lacing pages . 

Stet. Proofreading term which means to disregard 

correction mark. 

Story. A chain of linked text that occupies one or 

more columns or pages. 

Stripping-in. Manually pasting text or graphics 

on a page. 

Style sheet. A collection of attributes lor text, 

line, color or fill saved lor a particular file. 

Tabloid. A page (11 ' x 17') that is about double 

the size of A4 and hall the size of a broadsheet 

(newspaper size). 

Taper. The progression from one color to another 

in a graduated fill. 

Template. A file with preset options lor various 

attributes of text and graphics. 

Thumbnails. Miniature representation of pages 
used lor checking design and layout of an entire 

publication. 

TIFF. Short lor tagged image file format. A bit­

mapped file format lor storing scanned black and 
white, line art, grayscale and color images. 

Tiling. The process of breaking an image, which 
is larger than the paper on which it is to be printed, 

into smaller parts (tiles) the size of the paper, and 

then assembling the tiles. 
~·nt 
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color) or a shade of gray. 

Tone. The strength of a color or shade of gray, 

from solid to light. 

Typography. The art of selecting and using fonts. 

Verso. Left hand page or an even number page. 

Weight. The thickness of the strokes of a charac­
ter categorized into several weights starting from 
the thinnest (lightest) to the thickest (heaviest). 

X-height. The height of lower case letters without 

ascenders or descenders such as a c e x . 
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Tips and tricks 

Tips and Tricks In this section, we show you some of the 
techniques popularly used in graphic design. 

Circular Blends 
FreeHand 3.1 

• Draw the circular shape. 
Draw a line from the centre point of the circular shape 
downwards. Clone the line and rotate anti-clockwise go•. 
Duplicate three times the cloned line. 

• Move the third duplicated line clockwise, as shown in the 
first diagram. 

• Give the same thickness for all the lines but different colors 
or tints for each line. 

• Blend from one line to another (25 steps). Do the same to 
the other lines. 

• Cut the blends and Paste inside the circular shape from the 
Edit menu. 

Creating Transparencies 
• FreeHand 3.1 

Draw a rectangular box and fill it with a color of your choice. 
Draw a circle on top of the box, choose a color and click 
None for the keyl ine. 

• Ungroup it. 
• Clone and move it up to the right and fill il with while. 
• Select a point from each circle and blend it (25 steps). Send 

the blended object to the back of the rectangular box. 
• Clone the blended object. 
• Hold down the Option key to select the white circle within 

the blended front object and change its fill to the same color 
as that of the rectangular box. 

• Cut the blended front object. 
• Activate the box and paste the blended front object using 

Paste inside command from Edit menu. 

Chiseled type 
FreeHand 3.1 
Outline the shape of 'STOP' with a corner tool and fi ll it with 
a solid color. 
Draw the shadowed areas of the chiseled tellers. Make sure 
all the paths are closed. Select a darker tint for the color. 
Draw a thin highlight stroke tracing the edge of the shadow 
of each teller. 
Place both highlight stroke and shadowed area onto each 
respective teller. Bring both to the front. 
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Ellipses 
FreeHand 3.1 

• Draw a circle and two ellipses using Ellipse tool, positioning 
them as shown in the first diagram on the left. 
Ungroup all outlines. 

• Using the Knife tool and cut the intersecting points of all 
three elements. 
Delete the unwanted blue lines. 
'Select the intersecting mid points of the two red lines and 
join them. 
Clone the red line. 

• Join the cloned red line to the left half circle. Ensure that the 
path is a closed one and send this section to the back. 

• Join the next red line to the other half of the circle. Also 
ensure that the path is closed. 

• Fill both sides with color desired. 

Globe 
• FreeHand 3.1 

Draw a circle in 1-point line with no fill. 
Clone circle. 

• Pressing Option + Scale tool and set Horizontal 5% from 
centre. uncheck lines under setae options and click OK. 

• Select both circles and ungroup them. 
• Activate one corresponding point from the centre of each 

circle. 
• Blend (6 steps). 
• Clone the element in the second diagram. 
• Press Option+ Rotation tool and set it to 90• at centre. 
• Your completed globe should be similar to the third 

diagram. 

PageMaker's Duplication 
• PageMaker 4.2 
• Create a shape. 
• Go to Edit menu and copy shape or Command +C. 

Press Command + Option + V to paste and move the copied 
shape to position as shown in the second diagram. 

• Press Command + Option + V to duplicate as many shapes 
as desired. 
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Tips and t r icks 

In-line type 
• FreeHand 3.1 

Type text in Lubalin Graph bold, 24 points. 
• Set effects to lnline ... Background- width (3 points). 

color (white); Stroke- width (1 point); color (black). 
mitre limit (30•); Iterations -1. 
Set effects again in Type menu to lnline ... Background­
width (3 points). color (white); Stroke-width ( 1 point). 
color (black), mitre limit (30•); Iterations- 1. 

• Set effects to lnline one more time ... Background- width 
(3 points). color (white); Stroke- width (1 point). color 
(blue). mitre limit (30•) ; Iterations- 1. 

Neon type 
• FreeHand 3.1 
• Type 'N' in Helvetica bold, 80 points. 
• Convert to paths. go to Element menu and select Split 

elements. 
• Clone the 'N' and set line in 12-point black. 

Send to back. 
• TAB and select next 'N'. 
• Set 1-point line in white and fill with black. 
• Drag to select a pair of corresponding points as shown in 

the second diagram. 
• Blend (1 0 steps). 

Fill background with black. 

Emboss type 
• FreeHand 3.1 
• Type 'E' in Times bold, 90 points in 10% green. 
• Clone the 'E'. 
• Move position using Command + M and set Horizontal 

-D.03"; Vertical 0.03', color 40% green. 
• Duplicate using Command + D to the next position. 

selecting 100% green for its color and sent 'E' to back or 
Command+ B. 

• Fill background with 40% green, also sending it to back. 

FreeHand's Eraser 
FreeHand 3.1 

• Trace the outline of a shell using the Freehand tool. 
• Draw it off position. 
• While still holding down the mouse button for the Freehand 

tool, press the Command key to erase the off-positioned line 
by retracing over it. 

• Release the Command key and continue drawing without 
letting go of the mouse button. 
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Encircle Line Art 
FreeHand 3.1 
Draw an ellipse over the surf sail. 
Clone or Command + = and move position of ellipse slightly 
down. 

• Duplicate or Command + D for the two ellipses. 
• Use the Pointer tool and select all the rings, aligning them 

with Command +I. 
Ungroup the rings and cut the left and right side handles 
with the Knile tool. The two ellipses are now separated in 
two respective halves. 
Without dragging to separate the two respective halves, 
select the top halves and send to back. 

Compound Lines 
FreeHand 3.1 
Draw a closed path in 12-poinl black with no fill. 
Clone from Edit menu or Command + =. 
Go to Fill and line in Attributes menu. 
Change line to color desired. 
Select defaulted dotted lines under Dash while holding 
down Option key. 
Set segment lengths On (2 mm) and Off (5 mm) in 
Line pattern. 

Composite Paths 
• FreeHand 3.1 
• Draw two rectangles to create a frame and align them as 

shown in the first diagram. 
Command + U to ungroup and Command + J to join both 
rectangles. You may use commands from Elements menu 
for both steps. 

• Command + E or activate Fill and line from Attributes menu 
and fill frame with a custom texture and color desired. 

• Place from File menu a scanned image and send to back 
using Elements menu. 

• 
• • 

I I 
• • 

• 
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Ga l lery of works 

Gallery of works In this section, we showcase some of the MAC-graphics contributors. This illustration was done by lirst studying the Moorish architecture. The 
image was scanned and traced using FreeHand 3.1 . This was further duplicated and re-sized to form an interesting composition. Other elements like the sky and the 
long shadows were added to provide the dramatic effect. 
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This illustration was used for press advertising to promote color prepress on the MAC • drawn using FreeHand 3.1 • extensive blends were used for the background 
• fishes rendered with graduated tones • 19 1ayers and 67 colors used 
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Te r ms, Tips, Tricks 

G al l e r y o f w o r ks 

After scanning the picture, the artist experimented with the multiple effects of Photoshop. The effects as you can see are both stunning and unexpected. On page 294, 
the professional comic illustrator used the 'air-brush' effect in Photoshop successfully. 
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An invitation You are invited to submit samples of your work to be showcased in MAC-graphics. If I hey are selected, we will publish them with full credit line in 
MAC-graphics and present you with a complimentary copy. We prefer that you send your work in diskette form. Please include your name, address, occupation and 
details of your Macintosh configuration and software used. Please include a brief description on how your work was created. The address to send to is :The Curator, 
Octogram Publishing Private Limited, Singapore, Blk 79A Indus Road 102·406, Singapore 0316, Republic of Singapore or contact us directly on Tel : 065·2787373 
Fax : 065·2783737. Please include a self-addressed envelope if you want your diskette returned to you (postage will be paid by the publisher). 
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SOME USEFUL MAGAZINES AND BOOKS 
MacUser Electronic Publishing and 
950 Tower Lane, 18th Floor Printing 
Foster City, CA 94404, USA 29 North Wacker Drive 
Tel: 415-578-9770 Chicago, IL 60606, USA 

Tel: 312-726-2802 
MacWorld 
501 Second Street, #500 lTC Desktop 
San Francisco, CA 94107, USA 2 Hammarskjold Plaza 
Tel: 415-243-0505 New York, NY 10017, USA 

Tel: 212-371-0699 
Publish! 
501 Second Street Australian MacWorld 
San Francisco, CA 94107, USA lOG Communications 
Tel: 415-243-0600 37-43 Alexander Street 

Craw's Nest 2065, Australia 
Personal Publishing 
191 South Gary Avenue Macintosh 
Carol Stream. IL 60188, USA Neue Winterthurerstrasse 20 
Tel: 312-665-1000 8305 Dietikon, Switzerland 

The Seybold Report MacWorld 
6922 Wildlife Road Sodra Hamnvagen 22 
Malibu, CA 90265, USA S-115 41 Stockholm, Sweden 
Tel: 213-457-5850 

Designers on Mac 
Desktop Publishing Diana Burns 
363 Ridge Road Publisher: Graphic-sha 
PO Box 620025 
Woodside, CA 94062, USA 

SOME USER 
GROUPS 

Electronic Page Design 
Michael Gosney and 
Linea Dayton 
Publisher: Prentice Hall 

The Official Adobe Photoshop 
Handbook 
David Biedny and Bert Monnoy 
Publisher: Bantam Computer 
Books 

Typography Now The 
Next Wave 
Rick Poynor and Edward 
Booth-Ciibborn 
Publisher: Internes Books 

Real World FreeHand 3 
Olar Martin Kvern 
Publisher: Bantam Computer 
Books 

Using Aldus FreeHand 3.0 
Sharyn Venit and Bruce Fraser 
Publisher: Bantam Computer 
Books 

BCS•Mac Office 
Boston Computer Society 
48 Grove Street 
Somerville, MA 02144, USA 
Tel: 617-625-7080 

Berkeley Macintosh Users 
Group (BMUG) 
1442A Walnut Street 
Berkeley CA 94709, USA 
Tel: 415-549-2684 

Danny Goodman's 
Macintosh Handbook 
Danny Goodman, Richard Saul 
Wuram 
Publisher: Bantam Computer 
Books 

The QuarkXPress Book 
(2nd Edition) 
David Blatner, Steven Roth and 
Keith Stimely 
Publisher: Peachpit Press 

QuarkXPress Tips and Tricks 
David Blatner and Eric Taub 
Publisher: Peachpit Press 

Real World PageMaker 4 
Olar Martin Kvern and 
Stephen Roth 
Publisher: Bantam Computer 
Books 

Adobe Illustrator 3.0 
(3rd Edition) 
Tony Bove, Fred Davis and 
Cheryl Rhodes 
Publisher: Bantam Computer 
Books 

For the address of a user group 
nearest to you, contact : 

User Group Connection 
Apple Computer, Inc. 
M/S 36AA 
20525 Mariani Avenue 
Cupertino, CA 95014, USA 
Tel: 800-538-9696 
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About the Book 

Since 1987 the authors have been deeply fascinated by desktop publishing. They 
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MAC· graphics® is the culmination of the skills and technological know-how 
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MAC-graphic!! - A designer's visual guide to graphics 
for the Apple Macintosh by Lim & Gim 

SECOND EDITION, with disk 

MAC-graphic!! is a comprehensive graphic reference manual 
addressing the designers, printers, typesetters, serious DTP 
hobbyists, typographers, color separators and students -those 
who use type, color and grayscale regularly, and those who do not 
want to waste their time to obtain the right printed results: the 
results as proven in print, not on the monitor screen. The book 
bridges the gap between the design and the production process 
in desktop publishing. 

MAC-graphic!' illustrates clearly the possibilities of producing 
quality printed matter with the Macintosh. This manual puts together 
the key elements in pre-press production (type, tint, color, grayscale, 
image, rule, halftone, process color and graduated color) on the 
MAC. It shows you how they relate to each other in the process of 
graphic design -the art of visual communication. 

This new, updated, upgraded, and enlarged edition includes a disk 
containing The Color Wheel, a FreeHand document that provides a 
fast and easy way to calibrate your monitor and help you visualize 
colors more accurately on screen, and 12 CMYK color charts to 
help you quickly select and use the right color scheme. 

MAC-graphic!' is a useful guide not only to new DTPers but 
is also a useful companion to the graphic designer as well as 
the advanced MAC users in helping them to produce the printed 
results they want. 

Reviews of MAC-graphics*, first edition 

"The ultimate 'desktop' book for the graphic designer ... First buy 
your Mac, then get this book!" Tools of the Trade, USA. 

"Covers everything from typeface choices to color processing and 
line art ... a superior Mac graphics ald." The Bookwatch, USA. 

"Presents an immense amount of information in a relatively 
compact form." Computer Publishing Magazine, USA. 
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